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1. Introduction
1. Introduction

Welcome to the Em5b data collection system. The Em5b 
is designed to provide you a convenient, high-quality data 
collection system at a relatively low cost. This manual will 
explain the Em5b’s capabilities and functions.

Contact Information
To contact Decagon for customer support or questions:

• E-mail us at Em5b@decagon.com

• Fax us at: (509) 332-5158

• Call us at: 1-800-755-2751 (US and Canada only) or 
509-332-2756.

Warranty Information
The Em5b has a 30-day satisfaction guarantee and a one-
year warranty.

Seller’s Liability
Seller warrants new equipment of its own manufacture 
against defective workmanship and materials for a period 
of one year from date of receipt of equipment (the results 
of ordinary wear and tear, neglect, misuse, accident and 
excessive deterioration due to corrosion from any cause 
are not to be considered a defect); but Seller’s liability for 
defective parts shall in no event exceed the furnishing of 
replacement parts F.O.B. the factory where originally man-
ufactured. Material and equipment covered hereby which 
1
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is not manufactured by Seller shall be covered only by the 
warranty of its manufacturer. Seller shall not be liable to 
Buyer for loss, damage or injuries to persons (including 
death), or to property or things of whatsoever kind 
(including, but not without limitation, loss of anticipated 
profits), occasioned by or arising out of the installation, 
operation, use, misuse, nonuse, repair, or replacement of 
said material and equipment, or out of the use of any 
method or process for which the same may be employed. 
The use of this equipment constitutes Buyer’s acceptance 
of the terms set forth in this warranty. There are no under-
standings, representations, or warranties of any kind, 
express, implied, statutory or otherwise (including, but 
without limitation, the implied warranties of merchantabil-
ity and fitness for a particular purpose), not expressly set 
forth herein.

Repair Instructions
If your Em5b should ever require a repair, call Decagon at 
(509) 332-2756 or 1-800-755-2751 (United States and 
Canada). We will ask for your address, phone number, 
your Em5b’s serial number, and your current firmware 
version. For non-warranty repairs, we will also ask for a 
method of payment.

Before shipping your instrument to Decagon, please con-
tact Decagon to obtain a Request Maintenance Authoriza-
tion Number (RMA). This will allow Decagon’s repair 
staff to keep track of your Em5b. Once you have acquired 
an RMA, send your Em5b to Decagon. Please include a 
document listing the complete shipping address, name, 
and department of the person responsible for the instru-
ment, as well as a description of the problem. This will 
2
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better help our technicians and shipping department to 
expedite repair on your Em5b and ship it back to you.

Please pack your Em5b carefully. Ship it back in the carry-
ing case, preferably inside a cardboard box. Ship to:

Decagon Devices Inc.
2365 NE Hopkins Court

Pullman, WA 99163
3
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2. The Em5b and ECH2O 
     System 

Introduction
The ECH2O System is made of data loggers, sensors, 
telemetry, and software that help you measure soil mois-
ture and other environmental parameters accurately and 
cost effectively. Decagon's innovative sensors are the heart 
of the ECH2O System. Decagon also designed the system 
to be very easy to use (no programming needed). 

The Em5b is a 5-channel, self-contained data logger. It is 
housed in a white weather-resistant enclosure, making it 
suitable for outdoor operation in moderate weather cli-
mates. It is powered by 4 AAA-size alkaline batteries. Your 
Em5b is designed primarily to make soil moisture mea-
surements. It is the most cost effective logger in the 
ECH2O System. Decagon created the Em5b for research-
ers on a tight budget who want to measure large numbers 
of soil moisture sensors. 

Em5b Compatible Sensors
You can use the Em5b with the following ECH2O System 
sensors: 

• EC-5 ECH2O Soil Moisture Probe with 5 cm sensor 
length. 
4
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• EC-10 ECH2O Soil Moisture Probe with 10 cm sen-
sor length. 

• EC-20 ECH2O Soil Moisture Probe with 20 cm sen-
sor length. 

• ECRN-50 Rain Gauge with 1 mm tip resolution. 

• ECT Soil and Air Temperature Sensor. 

Software
The ECH2O System gives you three software options for 
working with your hardware and collected data. Choose 
one or more packages to fit your needs. 

ECH2O Utility
The ECH2O Utility is free software that is included with 
your purchase of an Em5b, Em50, Em50R, and DataSta-
tion. It provides a simple way to connect to and configure 
your ECH2O loggers. ECH2O Utility makes downloading 
and processing your measured data fast and easy. 

• Connect to ECH2O loggers directly or with radio 
telemetry.

• Set all logger configuration parameters with visual 
controls. 

•  Make real-time sensor measurements (scan sensors). 

•  Create Excel or text files with raw or processed data. 

• Create configuration and data files for use with 
ECH2O DataTrac. 

• Process data downloaded with ECH2O Utility 
Mobile. 
5
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ECH2O DataTrac
ECH2O DataTrac is the premier ECH2O System software 
designed to help you organize and visualize your measure-
ment data. DataTrac is particularly useful for the 
researcher who has several data measurement sites and 
doesn't want the hassle of managing the data after each 
download. It is the only ECH2O software that lets you 
easily apply custom calibration to sensor data. Along with 
most of the features of ECH2O Utility, DataTrac also 
offers: 

• Powerful charting engine shows data graphically. 

• Simple table view allows data manipulation. 

• View summarized data based on chart period. 

• Automatically organize and store data for each 
ECH2O logger. 

• Apply sensor-specific calibration to data. 

• Create reports with chart and summary data. Print or 
save as PDF. 

• Easily transfer data and configuration to other 
DataTrac users. 

ECH2O Utility Mobile. 
ECH2O Utility Mobile is designed to bring the usefulness 
of ECH2O Utility to the HP iPAQ line of handheld com-
puters (PDA). Use this software and your PDA in the field 
instead of your expensive laptop. This software will con-
figure your logger, download data, and make real-time 
sensor measurements. Like the desktop version, ECH2O 
Utility Mobile allows you to: 
6
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• Connect to ECH2O loggers directly. 

• Set all logger configuration parameters with visual 
controls. 

• Make real-time sensor measurements (scan sensors). 

• Create configuration and data files for use with 
DataTrac. 

• Create data files for use with ECH2O Utility. 

The ECH2O System also includes other loggers, teleme-
try, and sensors. Please consider these components as your 
measurement needs change.

Measurement Devices

ECH2O Check 
The ECH2O Check is a simple hand-held readout for the 
ECH2O probes. It works with the EC-5, EC-10, and EC-
20 volumetric soil moisture sensors. It displays single sen-
sor water content readings on a large-digit LCD. The 
ECH2O Check is well suited for use during sensor installa-
tion. 

Em50 logger
The Em50 is the best, most robust ECH2O data logger. It 
has 5 sensor ports and a dedicated communication port. 
This self-contained logger has a custom designed rugged 
enclosure for use in extreme weather conditions. It has 
more memory than the Em5b, storing over 36,000 scan 
sets (one reading for each port). The Em50 supports all 
the ECH2O System sensors including the new digital sen-
sors. 
7
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Other Sensors
In addition to all the sensors compatible with the Em5b, 
the following ECH2O System Sensors are also compatible 
with the Em50/Em50R loggers: 

• ECH2O-TE: measures volumetric water content, 
temperature, and electrical conductivity in soils or 
growing media. 

• LWS Dielectric Leaf Wetness Sensor: uses a state-
of-the-art method to detect leaf wetness. 

• Drain Gauge: measures drainage through a soil pro-
file. 

• EHT Temp/RH sensor: combines temperature 
and relative humidity measurements on one sensor.

The Em50R adds a spread-spectrum radio telemetry mod-
ule to the Em50 logger. The radio module is available in 
long-range 900 MHz and world-ready 2.4 GHz frequen-
cies. Use the telemetry in a low-power transmit mode or a 
higher power two-way mode that is more flexible. 

The DataStation is the radio base station for Em50R log-
gers operating in transmit mode. The DataStation is capa-
ble of collecting data from many loggers. This gives you 
one, convenient place to download all your data. 

Em5b Data Logging Scheme
The Em5b will not make sensor measurements until you 
set a measurement interval. You also need to configure the 
Em5b ports with the type of sensor plugged into each 
8



Em5b User’s Manual
2. The Em5b and ECH2O System
port. You can set these values using the software described 
in the next chapters. 

The Em5b Measurement Interval 
The measurement interval works relative to the real-time, 
24-hour clock inside the Em5b. The time when the Em5 
measure the sensors is not based on when the logger was 
configured. For example, when choosing a measurement 
interval of 120 minutes, the Em5b will store data every 
two hours, on the hour. The resulting data will show sen-
sor measurements hourly at 12:00 am, 2:00 am,..., 10:00 
pm. Choosing a measurement interval greater than 720 
results in one set of data stored per day.

NOTE: Setting the Em5b measurement interval to zero turns off 
sensor measurement and data storage. 

For most sensor types, the Em5b makes a measurement 
from each of the 5 sensor ports every 60 seconds, regard-
less of the measurement interval value. When the Em5b’s 
internal clock reaches the time to store a reading, the aver-
age value of all the 60-second sensor readings is stored. 
For example, if you set the measurement interval to 60, 
the Em5b will actually store an average of the past 60 sen-
sor readings. If you choose an interval of 1440, the Em5b 
will store one value that represents the average sensor 
value for the entire 24-hour period.

Configuring Em5b Sensors 
The Em5b requires you to identify the type of sensor you 
plugged into each sensor port. Identifying the sensor types 
correctly configures the Em5b hardware for that sensor. If 
you choose not to have a sensor plugged into one or more 
9
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of the logger’s ports, you can set that ports sensor type to 
“None Selected”. 

How the Em5b Stores Data 
The Em5b stores data for all five sensor ports for each 
measurement interval. If no sensor is connected to one or 
more of the logger’s ports, the Em5b will store a “0” for 
that port. The Em5b’s data memory is non-volatile flash. 
Removing the batteries or performing a system reset will 
not erase your data. 

Data Storage Size 
The Em5b stores over 3300 data scans. When the logger 
has filled its data memory, it begins overwriting the oldest 
data in the memory. 

Measurement Span 
Depending on the set measurement interval, the Em5b 
can read for several weeks to several years before its mem-
ory has filled. You can determine how many days of data 
your Em5b will hold by dividing the size of the data mem-
ory (3300 scans) by the measurement interval. For exam-
ple, an Em5b set on an hourly measurement interval will 
store 138 days, or about 4.5 months, worth of data. An 
Em5b set to 360 minutes (6 hours) will store data for 825 
days, or about 2.25 years.
10
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3. Setup and Installation   

Installation of the Em5b system involves loading software 
on the computer that you plan to use for communicating 
with your Em5bs, configuring the time, date, and opera-
tion of the Em5bs, and installing the Em5bs in the field 
with their relevant sensors.

Batteries
The Em5bs are shipped with a new set of AAA alkaline 
batteries. When the battery life indicator in the ECH2O 
Utility shows your Em5b’s batteries are less than 5%, you 
need to replace them. For information on replacing the 
batteries, see Chapter 7. 

NOTE: The internal data storage of the Em5b is non-volatile, so 
you will not lose data if you remove the batteries.

Software  
The ECH2O Utility software that is included with your 
Em5b is a standard Windows application that installs in 
the typical fashion. Occasionally, new versions of software 
will become available on our website. They can be 
accessed in the Em5b section of the Decagon website at 
www.decagon.com/echo/software.html. 

You can find your current software version in the “About” 
option of the Help menu in the ECH2O Utility. If you are 
connected to the internet, the Utility will check to see if 
there is a newer version available. If there is, it will direct 
11
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you to the web page where you can download it (see 
Chapter 4 for instructions on having the program check 
automatically).

NOTE: This manual documents the ECH2O Utility. However, 
most tasks that can be performed using ECH2O Utility can also be 
done using ECH2O DataTrac. For more information on using 
DataTrac, please see its user’s manual.

Configuring the Em5b
Before field installation, the Em5b logger needs to have 
parameters such as its name, date, time, measurement 
interval and installed sensors set or defined. The Em5b 
can be directly connected to your computer using the 9-
pin to 3.5-mm plug RS-232 cable (included with the log-
ger). To accomplish this, do the following: 

1. Open the ECH2O Utility.

2. Plug the 3.5 mm connector of the RS-232 cable into 
Port 1 of the logger, and plug the 9-pin connector into 
the serial port of your computer. Select the appropri-
ate COM port from the “Connect Via” menu, and 
click Connect.

3. Use the ECH2O Utility to set the name, date, time, 
and measurement interval (see Chapter 4). 

Installing the Em5b
To install the Em5b and sensors, do the following:

1. Install your probes as directed in their respective oper-
ator’s manual. Insert the sensors’ plug firmly into the 
12
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Em5b’s input ports. Unused inputs should be plugged 
to prevent dirt, water and insects from entering the 
case. Plugs are provided for covering unused inputs. 

NOTE: Ports 2-5 are the only ones compatible with the 
ECRN-50 Rain Gauge. Port 1 does not support the ECRN-
50.

2. On each side of the Em5b, there are three loop-holes. 
Use these to fasten the Em5b to a mounting post 
using the included zip-ties or a similar fastener. Make 
sure it is installed in an upright position, with the 5 
input ports underneath. In this position, rain and 
spray are shed by the enclosure and drip off without 
affecting the contents of the Em5b enclosure.

Cautions

•  Never immerse the Em5b.

• Make sure to install the Em5b upright, so that 
water cannot enter the input ports, which can 
result in damage to the logger. 

• There is a higher risk of lightning damage to the 
Em5b if using probes with extension cables. 
13



Em5b User’s Manual
4. Using the ECH2O Utility
4. Using the ECH2O Utility

Introduction
The ECH2O Utility provides a user-friendly interface for 
configuring and downloading the Em5b logger. After 
installing the program (see Chapter 3 for instructions), 
launch the program. You will see the main screen. Here 
you can set all logger configuration parameters with visual 
controls. Once connected, the main screen will look simi-
lar to the picture below.

The ECH2O Utility Main Screen

At the top of the program window is a toolbar for inter-
acting with the Em5b. To the left is a battery indicator. To 
the right are the “Connect Via” menu, where you can 
select a COM port; the Connect button (which displays 
14
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“Disconnect” when you are connected to an Em5b); the 
Download button, which downloads data saved on the 
Em5b onto your computer; and the Scan button, which 
scans all of the sensors connected to each port on the 
Em5b, and returns a real-time reading. These functions 
will be described in further detail in this chapter. Below 
are the most common tasks that can be performed with 
the ECH2O Utility, explained in detail.

Common Tasks

Configuring the Em5b
The Em5b doesn’t require any programming. It does have 
several parameters that control identity and function. Here 
is a brief description of each:

Device Name. Each ECH2O device should have a 
unique name. The default name is the unit's serial number. 
You can change this to any legal name you want. A legal 
device name uses upper and lower case letters, numbers, 
underscores, hyphens, and most upper-ascii characters. 
Spaces and most punctuation are not legal name charac-
ters.

Device Serial Number. When set in the factory, this is a 
read-only value.

Radio Settings. Only devices that have a radio module 
will support these options (Em50R, DataStation).

Measurement Interval. ECH2O loggers allow you to 
choose the measurement interval from 1 minute to 1 day. 
15
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A measurement interval of zero (0) stops the logger from 
making measurements.

Port Sensors. Em50 and Em5b loggers require you to 
identify the sensor type for each of the five sensor ports.

To change a parameter: 

1. Connect to your device.

2. Change one or more parameters.

3. Click “Apply” to send the parameter changes to your 
device.

NOTE: While the Em5b is connected to the ECH2O Utility, no 
sensor readings will be collected or stored. Be sure to unplug the RS-
232 cable from Port 1 to enable the Em5b to make measurements. 

Downloading Data
Once the Em5b is properly configured and installed, it will 
begin taking and storing measurements. Data can be 
downloaded in two ways. The Download New option down-
loads data recorded since the last download. Download All 
will download all data currently stored in the Em5b. The 
Download button on the toolbar downloads only the new 
data.

To download data, do the following:

1. Unplug any probe that is connected to Port 1 of the 
Em5b, and use the 9-pin serial cable to connect it to 
your computer. 
16



Em5b User’s Manual
4. Using the ECH2O Utility
2. Choose “Direct Serial” from the “Connect Via” menu 
and press the Connect button. If you encounter con-
nection errors, please see the Troubleshooting section.

3. Once connected to an Em5b, either click the “Down-
load” button on the toolbar, or go to the Data Menu 
and select a download option as described above. 

4. When saving a data file, the File Save dialog suggests a 
name based on the connected logger’s name and the 
time and date. However, you can enter any name by 
typing it into the “File name” field. After specifying 
the file’s name, format and save location, click “Save” 
and the Utility will download the data and create the 
file. 

5. ECH2O Utility can save your data in several different 
file formats. Choose the file format you prefer (see the 
next section). 

Data File Formats
When you save downloaded data, you have several file for-
mats to choose from:

• Processed Data Excel File (.xls): Converts the raw 
downloaded data into engineering values appropri-
ate for each sensor type. ECH2O Utility uses the 
default conversion equation for each sensor when 
converting raw data to processed data. This is the 
default file type.

• Raw Data Excel File (.xls): Saves the downloaded 
data as raw data so you can apply appropriate pro-
cessing. The raw data is separated into each type for 
sensors that have multiple measurement types. 
17
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• DataTrac Data File (.dxd): Saves the file in a for-
mat that DataTrac can import.

• Processed Data Text File (.txt): Performs the 
same function as a processed Excel file, but the data 
is saved as a tab delimited text file instead of a binary 
spreadsheet file.

• EchoLink Raw Data (.csv): Saves the data in the 
same comma delimited format as the older 
EchoLink software. 

• Raw Data (.csv): Saves the raw data in the form 
downloaded from the logger. 

NOTE: The DataTrac file format (.dxd) is a useful way to store 
data for later manipulation. Each .dxd file contains information 
about the ECH2O logger's settings, identity, and status along with 
the raw data for each sensor. ECH2O Utility will process a .dxd 
file into a processed data Excel file, a raw data Excel file, or a pro-
cessed text file. This allows you to re-process your raw data with dif-
ferent settings or file formats as needed.

Erasing Data
If you need to erase the data on your Em5b, go to Data > 
Erase Stored Data. You should erase your data if you 
change the Em5b’s configuration settings, such as what 
type of sensor is in each port. After selecting the Erase 
option, you will be asked if you want to continue. Click 
Cancel to return to the program, or Erase Data to con-
tinue. WARNING! Once this feature is activated, ALL 
stored data will be erased and cannot be recovered! 
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Instantaneous Measurements (Scan)
The ECH2O Utility gives you the ability to take real-time 
sensor measurements with your Em5b logger. This is 
most useful as a troubleshooting feature to test if a sensor 
is reading properly. You can also see how sensors react to 
environmental changes. To take this type of reading:

1. Click the “Scan” button in the toolbar, or go to 
Actions > Scan Logger Ports. The Em5b will take a 
reading on each of the ports, then display a screen 
similar to the one below:

2. All 5 ports are displayed, along with the measurement 
for each port in the units appropriate for the sensor. 
You can change measurement units in the Preferences 
Menu (see “Measurement Units” in Chapter 5). Click 
the sensor's name to see the reading as raw data.
19



Em5b User’s Manual
4. Using the ECH2O Utility
The five ports are displayed, along with the measurement 
for each port in the current selected unit. If nothing is 
plugged in to a port, the reading for that port will be zero. 

NOTE: Data measured in this manner will not be stored in the 
Em5b. 
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5. The ECH2O Utility Menus

The ECH2O Utility features six menus that allow you to 
access the program’s features. This chapter discusses the 
features of each menu.

The File Menu

Save Settings File
Selecting the “Save Settings File” option from the File 
menu will create a data file that contains all of the settings 
and information associated with the connected Em5b. 
This feature is useful for transferring logger configura-
tions between ECH2O Utility and ECH2O DataTrac. By 
default, the name of the settings file is the name of the 
selected Em5b. After naming the file and selecting where 
it will be saved, click Save to create the file. 

Convert Data File
ECH2O Utility will “process” or convert raw ECH2O 
sensor data to processed data. This feature works by read-
ing a file containing raw data and outputting the processed 
data into a different file. You can convert DataTrac data 
files (*.dxd) and EchoLink download files (*.csv or *.txt). 
Only files saved with ECH2O Utility, ECH2O Utility 
Mobile, or EchoLink can be converted to processed files. 
You can choose to save your processed files as an Excel 
file or text file.
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Edit Menu

The Preferences Menu
The main feature of the Edit Menu is the Preferences 
menu. The Preferences menu features four tabs for navi-
gation: Measurements, Data Files, Communications, and 
Application. Below are a list of the most common tasks 
that can be performed in each tab.

1. Measurements Tab 

Measurement Units. These are the unit values that will be 
displayed when downloaded data are saved as Excel, pro-
cessed, or raw data files. ECH2O Utility supports display-
ing some measurement data in multiple units. For 
example, it allows you to choose degree Celsius or degree 
Fahrenheit for temperature sensors. To set your prefer-
ences for measurement units, choose the “Measurements” 
tab in the ECH2O Utility Preferences window. 
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Locate the type of measurement and select a unit from the 
drop-down menu next to it. Click “Close” to apply the 
changes.

Power Noise Filter. The AC electrical power in your office or 
home can add a subtle amount of noise to the data logger 
sensor measurements. The logger's Power Noise Filter 
setting is designed to eliminate this electrical noise that 
comes from the AC power distribution system. You 
should set the value of the Power Noise Filter to match 
the frequency of the power cycle where you live. In North 
America and most of Asia, this is 60 Hz (the default 
value). In most of Europe the electrical frequency is 50 
Hz. This feature only needs to be set once, as the program 
will automatically update the filter of each device that it 
connects to. 

2. Data Files Tab

Column Headers. The column header gives each column a 
title corresponding to the port number, measurement 
type, and unit. Column headers for saved data files are 
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turned on by default, and apply only to processed and raw 
MS Excel data, as well as processed text data. De-select 
“Include column headers” to turn off the column headers 
for these file types.

Setting Date/Time Format for Data Files. You have control 
how the date and time values are formatted in the data file. 
By default, the time and date are formatted using the set-
tings in the Windows Regional & Language Options con-
trol panel. You can modify this to display the date and 
time in dd/mm/yyyy format with either a 12- or 24-hour 
clock. To change the format, select an option from the 
menu, then click “Close” to apply the changes. 

3. Communications Tab
The Communications preference tab has items that con-
trol how the serial communication works between 
ECH2O Utility and your Em5b. Generally you should not 
adjust these settings unless you are experiencing trouble 
connecting to your Em5b.
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Direct Command Retries. ECH2O Utility automatically retries 
commands it sends to your Em5b when there are errors. 
For most circumstances, the default retries work well. If 
you experience unreliable communication with your 
Em5b, you can try increasing the Direct Connect Retries.

Maximum Baud Rate. The Em5b only supports communi-
cating at 9600 baud. ECH2O Utility knows this, and there-
fore this setting is ignored for the Em5b. 

Communications Port List. ECH2O Utility is compatible with 
most USB-to-Serial adapters. Some models of USB-to-
Serial adapters are not found by the serial port enumera-
tion feature of ECH2O Utility. If your model of USB-to-
serial adapter is not recognize, enable “Force find all Com-
munication Ports” in the Preferences Menu by going to 
the Communication tab, and enabling the check box at the 
bottom of the screen. Enabling this option may find other 
serial ports that are not available for use by the ECH2O 
Utility (for example, modems installed in your computer). 
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4. Applications Tab

Automatic Internet Version Check: ECH2O Utility will auto-
matically check for a newer version using Decagon's inter-
net version check engine. It will notify you when a newer 
version is available as long as your computer is connected 
to the internet. You can turn off the automatic check by 
un-checking this option. You can manually check for 
updates anytime using the “Check for ECH2O Utility 
Updates” option in the Help menu. 

Automatic Clock Synchronization. By default, the ECH2O 
Utility automatically synchronizes your logger's date and 
time to the time set on your computer. You can disable 
this feature by un-checking this option. You can also 
update the date and time in your logger anytime it is con-
nected by selecting Actions > Set Date/Time. 

Error Log File. The ECH2O Utility keeps a log file of 
errors and events. Adding more messages to this file is 
useful for troubleshooting. Check this option to add more 
error and event messages to the error log. 
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Date and Time Display in the ECH2O Utility: You have con-
trol how the date and time for your Em5b is displayed in 
the toolbar status area. By default, the time and date are 
formatted using the settings in the Windows Regional & 
Language Options control panel. You can modify this to 
display the date and time in dd/mm/yyyy format with 
either a 12- or 24-hour clock.

Data Menu
The Data menu has three options: Download New Data, 
Download All, and Erase Stored Data. For more information 
on these functions, please refer to their respective sections 
in Chapter 4.

Actions Menu

Connect/Disconnect
Performs the same function as the connect/disconnect 
button in the toolbar. It initiates a data communication 
connection between your Em5b and your computer. You 
must first connect to your Em5b before downloading 
data.

Get Settings
This command retrieves all the port and configuration set-
tings from your Em5b. These settings are automatically 
collected when you connect to your Em5b. You can use 
this option to make sure your changes are stored in the 
Em5b. 
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Apply Settings
Applies the parameters you changed to your Em5b. This 
operates just like the Apply button on the main screen. 
This option is only available when there are parameter 
changes available to send to the Em5b. 

Scan Logger Ports
This option allows you to take readings from each port 
independent of the others. See the section “Instantaneous 
Measurements” in Chapter 4 for details and procedure.

Set the Date/Time
When you select this action, the ECH2O Utility will set 
the Em5b’s time and date to be the same as the time and 
date on your computer.

Device Tools
The Device Tools submenu contains the following items:

Test Device Firmware
This option is useful in determining if you have any firm-
ware (the internal software that runs the Em5b) errors. To 
initiate a firmware test, select Actions > Device Tools > 
Test Device Firmware. This will automatically test the sta-
tus of your Em5b’s firmware, and report if it reads as Bad 
or Good.

Initialize Radio Module
This option does not work with the Em5b because the 
Em5b does not support a radio module. This option 
applies to Decagon’s Em50R radio-enabled loggers.
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Initialize Device
Initializing your Em5b is a form of a hard reset. ECH2O 
Utility resets your Em5b and re-writes all the logger set-
tings. All your measurement data is erased. This option is 
useful for troubleshooting a logger that is not working as 
expected. 

NOTE: Initializing your Em5b will delete all stored data. Make 
sure any data has been downloaded out of the Em5b before initiating 
a reset.

Window
The Window Menu contains the Show Terminal com-
mand. The terminal window allows you to directly enter 
commands for your Em5b, and is mainly used for trouble-
shooting and diagnosis. Contact Decagon for more infor-
mation about this function. 

Help
The Help Menu allows access to the ECH2O Utility help 
file, which allows you to check for program and firmware 
updates, and displays information about your copy of the 
ECH2O Utility. 

ECH2O Utility Help
This menu item opens the help file. It contains some of 
the information found in this manual. 

Check for Utility Updates
This function checks for the newest available version of 
the ECH2O Utility. Make sure you are connected to the 
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internet, then select Help > Check for ECH2O Utility 
Updates. The program will check to see if there is a newer 
version available. If there is, it will direct you to the web 
page where you can download it. To check for a newer 
version of the ECH2O Utility, choose this menu item. 
Checking for updates for the ECH2O Utility uses Deca-
gon's version check web engine. Your computer must be 
connected to the internet for this feature to work.

Check for Device Firmware Updates
This menu item is only available when you are connected 
to an Em5b (or other ECH2O device). It compares the 
firmware version of your Em5b with the latest version 
available from Decagon. You can download a firmware 
updater when a new version is available. Your computer 
must be connected to the internet for this feature to work. 

About the ECH2O Utility
This menu item opens the “About” window. You can see 
the version of your copy of ECH2O Utility here.
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PROBLEM: The ECH2O Utility tells me the communi-
cation port I want to use is in use by another application, 
but I don't think any other programs are running. 

SOLUTION: Some PDA synchronization software mon-
itor serial communication ports. Disable Microsoft’s 
ActiveSync or Palm’s HotSync system software while try-
ing to use the serial port with the ECH2O Utility. 

PROBLEM: My USB to Serial adapter is not showing in 
the communication port picker. 

SOLUTION: Enable “Force find all Communication 
Ports” in the Preferences Menu by going to the Edit 
Menu, clicking Preferences, then the Communication tab, 
and enabling the check box at the bottom of the screen. 
Enabling this option may find other serial ports that are 
not available for use by the ECH2O Utility (for example, 
modems installed in your computer). 

PROBLEM: ECH2O Utility tells me it lost connection 
with the ECH2O device.

SOLUTION: A noisy serial connection can sometimes 
disrupt the connection between the ECH2O Utility and 
the Em5b. If this error happens regularly when you are 
direct connected to your device, try setting your baud rate 
lower or increasing the number of times the ECH2O Util-
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ity retries the commands it sends to your device. Choose 
the “Communications” tab in Preferences to set the Maxi-
mum Baud Rate lower or increase the number of Direct 
Connect Retries. 

PROBLEM: My logger stopped making measurements.

SOLUTION: Here are some steps to try:

1. Make sure you are not connected to the logger. The 
ECH2O loggers are not designed to make sensor mea-
surements when connected to the computer. Please 
remove the serial cable from the logger to re-enable 
making and storing sensor measurements.

2. Make sure the measurement interval is not set to 0. 
The ECH2O loggers don't make any measurements 
when the measurement interval is set to zero.

PROBLEM: My data shows “ * * * ” in the Scan Ports 
window or in the data file.

SOLUTION: The three stars mean the raw data was out 
of the expected range for the sensor. This could indicate a 
broken sensor. For Em5b and Em50/Em50R loggers, 
make sure your sensor type is set correctly for the type of 
sensor you have in each port.

PROBLEM: My sensor data doesn't seem correct.

SOLUTION: There are many issues that affect the qual-
ity of the sensor measurement. Please see the user manual 
for your particular sensor for help troubleshooting your 
the data collected by your sensor.
32



Em5b User’s Manual
7. Maintenance
7. Maintenance

If installed correctly, the Em5b requires little maintenance. 
The main requirement is that batteries need to be replaced 
when their charge becomes too low. The Em5b is 
designed to use alkaline batteries, and is shipped with a 
new set. When the battery life indicator in the ECH2O 
Utility shows your Em5b’s batteries are less than 5%, you 
need to replace them.

To change the batteries, do the following: 

1. Unplug sensors from the Em5b.

2. Disengage the tabs on each side of the bottom plate, 
and pry the bottom out of the case. 

3. Slide the logger and batteries out of the case. Replace 
the batteries, making sure to install them with the 
proper polarity. IMPORTANT: Once the new bat-
teries are installed, press the silver reset button on 
the Em5b board to make sure it starts up prop-
erly.

4. During the time that the batteries are being changed, 
all current settings and data are protected, but readings 
will not be taken. 

5. The Em5b clock is not saved when changing the bat-
teries. Therefore, after changing the batteries, connect 
to the logger with the ECH2O Utility and update the 
time (see Chapter 4).
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6. Slide the Em5b assembly back into the case as shown, 
taking care to orient the circuit board into the align-
ment slots in the upper case. Place the bottom plate 
firmly into position, making sure the tabs fully snap 
into their respective slots.

Em5b board placement

Long Term Maintenance
When caring for the Em5b over an extended period of 
time, be sure to do the following periodically:

1. Check the battery holders and make sure they are 
clean and free of corrosion.

2. Check that the sensor ports are clean, and that the 
sensors are making good contact with the ports.

3. Check the integrity of the case; make sure that the bot-
tom case cover seals tightly, and that the tabs are still 
intact. Empty ports should also be plugged to prevent 
insects and dust from entering the logger and damag-
ing the hardware.
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This chapter gives a brief description of the sensors com-
patible with the Em5b. For more information on each of 
the described probes, please see the operator’s manual for 
that sensor.

EC-20, EC-10, & EC-5 Soil Moisture 
Sensors
The ECH2O probes measure the dielectric constant of the 
soil to determine the volumetric water content of the soil. 
Since the dielectric constant of water is much higher than 
that of air or soil minerals, the dielectric constant of the 
soil is a sensitive measure of water content. The ECH2O 
probe has a very low power requirement and high resolu-
tion.

Choosing a Soil Moisture Probe
The following table can help you decide which ECH2O 
probe is right for your measurement needs. Each probe 
model offers different trade-offs with features and sample 
size. 

NOTE: This table compares the ECH2O models that 
are compatible with the Em5b. For a comparison 
including other ECH2O probe models, visit 
www.decagon.com/echo.   
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*Measuring volumetric water content above 60% in non-
mineral soils and growth media requires a quadratic cali-
bration equation. Most mineral soils are fully saturated 
below 45% VWC. 

Default Conversion Equations 
ECH2O Utility uses the following default conversion 
equations for the ECH2O probes. 

EC-5
Mineral Soil: m3/m3 = 0.00085 * RAW - 0.481
Potting Soil: m3/m3 = 0.0013 * RAW - 0.696

EC-5 EC-10 EC-20

Water content 
measurement 

range

0-100%* 0-40% 0-40%

Low cost Best Best Best

Accuracy in 
high EC

High Low Low

Accuracy in 
variety of 
textures

Best Good Good

Use in pots & 
greenhouses

Best Good Fair

Sample sizes Fair Good Best
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Rockwool: 
m3/m3 = 6.28x10-7 * RAW2 + 1.37x10-4 * RAW - 0.183

EC-10:
Mineral Soil:  m3/m3 = 0.000571 * RAW - 0.376 

EC-20
Mineral Soil:  m3/m3 = 0.000424 * RAW - 0.29 

where RAW is the raw measurement value recorded by the 
Em5b. 

The ECH2O probes can be used with any port on the 
Em5b.

ECH2O ECT Temperature Sensor
The ECT Temperature sensor is suitable for long-term 
monitoring of soil or air temperature. Accurate air temper-
ature measurements require the use of a radiation shield. 
Decagon can provide an appropriate shield for ECT use 
in air. The ECT Temperature sensor can be used with any 
port on the Em5b. 

Default Conversion Equations
The default conversion equation for the ECT first calcu-
lates an intermediate value with a log transform (natural 
log), then the temperature in °C from a 3rd-order poly-
nomial: 

x
4095
RAW
------------- 
  1– 
 ln=

C 25.02 x 22.84– x 1.532 0.08372x– + + +=°
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This equation offers 0.5 °C accuracy in the range of -40 to 
+60 °C. 

The ECT temperature sensor can be used with any port 
on the Em5b.

ECH2O Rain Gauges
The ECRN-50 and ECRN-100 are simple self-emptying 
electronic rain gauges. They are made of durable weather-
resistant plastic that is UV-resistant. You can configure the 
Em5b to treat the data collected by the Rain Gauges as 
standard precipitation or as a volume data. Configured as 
volume gauges, they are useful for measuring the output 
of irrigation systems in terms of gallons (or liters) per 
hour. 

The ECRN-50 is best used for measuring irrigation 
events. The sensor has a resolution of 1 mm. 

The ECRN-100 is a standard 0.01 inch rain gauge. It is 
best used for measuring rainfall. 

NOTE: The older model ECH2O ECRN Rain Gauge used 
with the Em5 loggers is not compatible with the Em5b. Please con-
tact Decagon for an ECRN upgrade kit that will allow you to use it 
with the Em5b. 

Default Conversion Equations
The Em5b uses an accumulating counter for storing rain 
gauge tip events. To calculate that number of tips for one 
time interval (interval n), you compare it to the previous 
interval (interval n-1).
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tips = RAWn - RAWn-1                   for RAWn > RAWn-1 
tips = (65535 - RAWn-1) + RAWn  for RAWn < RAWn-1

ECRN-50 precipitation is 1 mm per tip; volume is 5 mL 
per tip. ERCN-100 precipitation is 0.01 in. per tip. 

The ECRN-50 can only be used in ports 2 - 5 on the 
Em5b, and will not work correctly if plugged into port 1.

Millivolt Sensor
The Em5b uses a 12-bit analog-to-digital converter with a 
3000 mV excitation. You can record the millivolt response 
of analog sensors using the “Millivolt Sensor” selection 
for a sensor choice. 

Default Conversion Equation
millivolts = RAW * (3000/4096)

The Millivolt sensor selection can be used with any port 
on the Em5b. 
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Application of Council 
Directive:  89/336/EEC

Standards to which                  EN61326: 1998
conformity is declared:            EN55022: 1998

Manufacturer’s Name: Decagon Devices, Inc.
2365 NE Hopkins Ct
Pullman, WA 99163 USA

Type of Equipment:              Data collection system

Model Number: Em5b

Year of First Manufacture:        2006
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